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SETTING UP KEY READER 
Before beginning the installation of FleetView 7.30 for Fixed Wing, the KeyReader must be set up.  This is 
the device to which you will be inserting the DataKey™ to download flight data to your PC. (See minimum 
computer configuration requirements.) 
  

 
  
First, connect the cable to the Key Reader and to your PC.  The connection will run from the Key Reader 
Port to a Com Port or USB port on your PC’s hardware. If your computer does not have an available 
COM port then a third party ‘USB to Serial port converter’ device can be used. 
  
Note: IT IS NOT necessary to disconnect the printer cable from your computer to connect FleetView.  The 
Key Reader will function with the PC’s installed COM or USB Ports. 
  
Next, connect the power cable from the Key Reader to a power supply. 
  
Power on the Key Reader by pressing the switch to the "ON” position.  Confirm that that the “POWER” 
LED is lit. 
  
To use a key, insert the key and turn to the right until the key is firmly in place.  If the key is not inserted 
correctly, FleetView will notify you when attempting to use the key with the program. 

 
Click OK, Check Key 

  

  
  



MINIMUM COMPUTER CONFIGURATION 
  
To use this FleetView software program effectively, the computer should adhere to the following minimum 
configurations: 

     Have at least a 64MB memory. 
     Have at least a Pentium® or an equivalent AMD® class CPU. 
     Have at least an 800 by 600 pixels display setting. 
     Have at least 100 MB free disk space 
     Have at least a Windows 98, ME, NT 4.0, 2000 or XP operating system. 
     Have an Internet Explorer (IE), version 6 or higher. 
     Have the Microsoft Excel software installed, if you are going to use the Excel file export 

function. 
     Have the Microsoft Outlook configured, if you are going to use the automated FleetView 

email feature. 
  
  
Warning: The Pratt & Whitney ECTM software has a restriction on the filename and pathname. It 
could not handle long filenames. The filename should be in an 8.3(DOS) format if you are going to use 
the Pratt & Whitney software. Also, the pathname and the filename should not exceed thirty five (35) 
characters.  If for some reason you do not adhere to these restrictions, the translated data will not be 
loaded into the Pratt & Whitney ECTM database. (This warning is only valid if you have the Pratt & 
Whitney software installed.) 
  



  

GETTING STARTED-INSTALLATION 

Congratulations on purchasing or upgrading to FleetView 7.30 for Fixed Wing.  In order to operate this 
program effectively, it must first be installed on the computer to which you will be downloading data from 
the DataKey™. It is recommended that you always make a backup copy of the database, if you have one 
from a previous FleetView version, before installing this FleetView 7.30 software. Be sure to store the 
backup copy in a safe place.  For FleetView to function properly, certain conditions must exist.  The 
following procedure will direct you in installing the FleetView 7.30 for Fixed Wing program to your 
computer. Once you insert the FleetView install CD-ROM in your computer, the installation procedure will 
start automatically. Please wait a little bit to let your computer to respond, and follow the installation 
instructions. However, if the installation does not start automatically, follow steps 1 through step 3, and 
proceed from there. Also, please read all the information on the relevant windows screens to make a 
successful installation. 

 Warning: You should not add yourself to the Administrators group and you should avoid running your 
computer while logged on as an administrator. For most computer activity, log on as a member of the Users 
or Power Users group. If you need to perform an administrator-only task, log on as an administrator, 
perform the task, and then log off. 

Running Windows NT/2000/XP as an administrator makes the system vulnerable to Trojan horses and 
other security risks. The simple act of visiting an Internet site can be extremely damaging to the system. An 
unfamiliar Internet site may have Trojan horse code that can be downloaded to the system and executed. If 
you are logged on with administrator privileges, a Trojan horse could do things like reformat your hard 
drive, delete all your files, create a new user account with administrative access, and so on. 

You should add yourself to the Users or Power Users group. When you log on as a member of the Users 
group, you can perform routine tasks, including running programs and visiting Internet sites, without 
exposing your computer to unnecessary risk. As a member of the Power Users group, you can perform 
routine tasks and you can also install programs, add printers, and use most Control Panel items. If you need 
to perform administrative tasks, such as upgrading the operating system or configuring system parameters, 
then log off and log back on as an administrator. 

  

 
1. At your computer, click on START at the menu task bar. 

 
2. From the START menu, click on RUN. 



3. Insert the installation CD-ROM disk into your CD-ROM drive. In case the install program did not 
start automatically, do the following: In the RUN box, enter “D:\Setup” or “E:\Setup” depending on 
the drive letter containing your installation CD-ROM, and click OK. 

 
  
4.  Wise install Wizard Dialog box will appear to begin the Installation process. 

 

 
 
5. If this is a new installation of the FleetView 7.30 for Fixed Wing program, you will be prompted to 

answer several questions during the setup procedure. 
 

 
Click Next twice 

 



6. The License Agreement page will be displayed.  Read through the license agreement.  The ‘I Agree’ 
radio button must be selected before the ‘Next’ button will be activated.   Click Next will advance to 
the next screen. 

 
  
 

7. FleetView 7.30 for Fixed Wing will show some information regarding the computer minimum 
configuration requirements. 

 

 
Click Next 

 



8. FleetView 7.30 for Fixed Wing automatically selects a destination directory.  To change the 
destination directory, select Browse. Click or type the new location. 

 

 
Click Next 

    
9. FleetView 7.30 for Fixed Wing is now ready to install. 
 

 
Click Next 

10. Install CD-ROM Disk begins copying.  
 

 
 



11. Following the transfer of data, FleetView 7.30 for Fixed Wing will update the system configuration. 

 
 
12. Click finish to continue with the rest of the installation procedure. 
 

 
Click Finish 

13. Following the system configuration update, the program might ask the user to restart the computer.  
  
  



  

INITIAL SETUP 
 1.   To begin using, click on START at the menu task bar. 

 
 

2.      Point to Programs. 

 
 

3.      Slide to FleetView Fixed Wing. 

 
 

4.      Click on FleetView. 
 

  
 

5. The FleetView 7.30 for Fixed Wing Welcome screen appears.  Answer the following prompts in 
order to configure the program. 

 

 
Select Yes or No, Click Next 

  
  
6.      If No is selected, the Database Directory must be set.  FleetView automatically provides a directory 

name.  To change the directory, type in the new directory where the provided one is displayed. 
Note: The FleetView for Fixed Wing database does not have to be on the same drive as the FleetView 
program.  If it is not, change the path to accurately reflect your database location. 



 
Click Next, Go To Step 12 

  
7.     If Yes is selected, FleetView 7.30 for Fixed Wing will prompt you for the location of the directory 

containing the existing Fleetvw.cfg file. 

 
Click Next 

   
8.      FleetView 7.30 for Fixed Wing will then convert existing files to the new format. 

 
Click Start Convert Tool 



9. In order to use old data files in FleetView 7.30 for Fixed Wing, the files MUST be converted.  
This screen lists the folders containing old data files.  Double click a folder to display the files. 

 
 
10.   To select a file for conversion, click the box next to the file name so a check mark appears.  To 

deselect the file, click the box so the check mark disappears.  To select the entire folder, click Select 
All.  When the files are selected, click Convert. 

 
Select Files, Click Convert 

  
11.   FleetView 7.30 for Fixed Wing will begin to convert old data files.  When the conversion of all files is 

complete, click Done. 
12.   Initial Setup of FleetView 7.30 for Fixed Wing is complete,  click Finish 

 



After initial setup is complete, the next time FleetView 7.30 for Fixed Wing is run; the set up screens 
will not appear in the main FleetView program. 
  

Database Structure 
The FleetView database is a three-tier structure and it should at least consist of a Base folder, an Aircraft 
folder and Data File.  Normally this database structure is generated automatically, however if you 
experience some difficulties, then this structure could be also created manually with the Windows Explorer. 
The procedure is as followed: 

1.      Open ‘Window Explorer’. 
2.      Expand the ‘C:’ drive. 
3.      Expand the ‘KeyData’ folder or the name that you selected when installing the FleetView 

program. (Please see step 6 as described above.) 
4.      Left click on ‘File’ in the menu bar at the top of the screen. 
5.      Slide down to ‘new’ in the dropdown menu and then over to ‘Folder’. 
6.      Left click on ‘Folder’. 
7.      Name the new folder ‘Base’. 
8.      Expand the ‘Base’ folder. 
9.      Left click to highlight the ‘Base’ folder. 
10.   Left click on ‘File’ in the menu bar at the top of the screen. 
11.   Slide down to ‘new’ in the dropdown menu and then over to ‘Folder’. 
12.   Left click on ‘Folder’. 
13.   Name the new folder ‘Aircraft’, or the name of your aircraft. 
14.   Click on ‘View’ in the menu bar at the top of the screen and then on ‘Refresh’. 

  

Keyview DOS Database Structure Conversion 
In case you missed the above conversion that only run once, you could still do a manual restructuring of the 
old DOS Keyview database. The procedure is as followed: 

1.      Open ‘Window Explorer’. 
2.      Expand the ‘C:’ drive. 
3.      Expand the ‘Keyview’ folder. 
4.      Expand the ‘Database’ folder. 
5.      Left click to highlight the ‘Database’ folder. 
6.      Left click on ‘File’ in the menu bar at the top of the screen. 
7.      Slide down to ‘new’ in the dropdown menu and then over to ‘Folder’. 
8.      Left click on ‘Folder’. 
9.      Name the new folder ‘Base’. 
10.   Click on ‘View’ in the menu bar at the top of the screen and then on ‘Refresh’. 
11.   Left click and drag your aircraft folder into the ‘Base folder. 
12.   Close or minimize ‘Windows Explorer’ and start the file conversion process as described in 

bullet 10 in the previous section. The conversion module could be accessed through the 
FleetView menu bar ’Tools’ and select ‘Convert’. 

  
Note: The above manual Keyview DOS Database Structure Conversion procedure is only valid if you are 
an old DOS Keyview user. 
  



FLEETVIEW’S MAIN PAGE 
The Main Application Page is where FleetView’s major functions can be accessed. 

 
FleetView Main Page 

THE FLEETVIEW APPLICATION  
  
This main menu is where the major functions can be accessed. You could select data files for manipulation, 
and be able to select from the many sub-menus.  The following pages provide a detailed description of each 
menu item found in the main menu. 
  

• MENU BAR: Used to select and perform operations within the FleetView 7.30 for Fixed Wing 
program.  

  
• DATA FILES WINDOW: Displays specific functions according to the file open in the Database 

Window.  To view report, double click the Number, Description, or Time Stamp.  
  

• REPORT WINDOW: Displays reports concerning specific aircraft according to Data File 
Window selection.  

  
• DATABASE WINDOW: Displays all folders contained within the Database.  Double click 

specific folder to open.  
  
Note: 
  

• If you were using KeyView and FleetView and converted old data files, FleetView 7.30 for Fixed 
Wing will use the converted database structure (Base/Aircraft/Data File).  

  
• If you did not convert from the old directory, the new directory will be C:\Keydata, or whatever 

selection was made during the installation procedure. Make sure the database structure is a three-
tier one (Base/Aircraft/Data File).  



CONFIGURATION SETUP PROPERTIES 
During normal operations, the FleetView 7.30 for Fixed Wing configuration setup can be changed. 
  
1.      Click on menu item View, slide to Options and click. 
  
2.      Properties Window Display: 
  
The Properties Window Display allows access to the following tabs. 

• Directory  
• ECTM  
• Key Reader  
• Tools  

DIRECTORY TAB 

  
 

Database Directory 
Location of FleetView 7.30 for Fixed Wing Database folder. (Base/Aircraft/Data File structure). 

ECTM Directory 
Location of the Windows Pratt and Whitney’s Engine Condition Trend Monitoring System Program. (I.e. 
where the program is installed.)  If this Windows ECTM® program is not installed or if the Internet based 
WebECTM® is not used, leave this entry blank. 
Note: In case the WebECTM (Internet based) program is used then this is the translation result directory as 
entered by the user and not the installed directory. 

Convert Module Location 
The directory path location of ConvertModule.exe.  This field is filled in automatically during installation. 



Translate Module 
The directory path location of TranslateModule.exe.  This field is filled in automatically during installation. 

ECTM Mode 
Selection to use either the WebECTM internet based program or the Window’s Pratt and Whitney’s Engine 
Condition Trend Monitoring System Program. (i.e. the program that will receive the engine data 
translations.)  
  

 ECTM TAB 

 
  

Altitude Control 
This field is used to place limitations on power check data being entered into the Pratt & Whitney ECTM 
IV Program.  The Power Check Altitude selection allows you to define a range of altitudes that will be used 
in determining which power check reports are suitable for translation into the ECTM program.  The default 
values are a minimum of zero (0) feet and a maximum of 51,000 feet.  If these default values are kept, 
FleetView will consider all power check reports suitable for translation.  If for example, you change this to 
a range of 5,000 to 10,000 feet, only power checks which were recorded within that range of altitudes 
(5,000 feet to 10,000 feet) will be used when doing a translation of data to the ECTM program.  Make your 
selection, click the ‘Save Aircraft Config File’ button, and then click the OK button to save the selection. 
  

Trends Setup 
The Trends Menu’s locations are displayed in the Directory tab.  Normally the location for the Windows 
ECTM directory will be “C:\TREND”.  Depending whether or not you are using the program, a number of 
configuration options may be available to you.  To access and configure the program you must first locate 
the directories.  If the directory is located on your C drive, access the files and then double click on the 



specific directory folder.  Finally, locate the Windows ECTM program and open it.  The first screen you 
access should be the Setup screen in the ECTM program.  Follow the instructions on-screen and use the 
given numbers or characters to select the options you want to configure.  Also, at anytime press the F1 key 
on your keyboard to display the topic description.  This tool will assist you in properly configuring your 
Windows ECTM program. 
  
However, if you are using the WebECTM internet based program, the ECTM directory displayed in the 
Directory tab is the translation result of the FleetView software. This directory name is entered by the user 
before the translation process. The files in this ECTM directory is the input for the WebECTM software. To 
import these translated files please refer to the WebECTM instructions supplied by Pratt & Whitney. 
  
Warning:  All attempts to perform a Trend analysis on the data read by this 
program must be done only by fully qualified personnel as defines by Pratt & 
Whitney Canada Requirements. 
  

KEY READER TAB  

 
The Key Reader Tab controls PC communication with KeyReader.  KeyReader is the device that connects 
to the PC’s COM Port.  The DataKey is inserted into Key Reader in order to read data from the key. 

Key Port 
PC Port (COM) the Key Reader connects to. 

Baud Rate 
This field allows you to select speed at which you would like the computer and KeyReader to 
communicate.  The choices are 1200, 2400, 4800, and 9600.  Normally, the 9600 setting works well.  The 
faster your computer can accommodate baud rates, the better.  However, if you have trouble 
communicating with the KeyReader at 9600, select a slower baud rate. 



Test Button 
Test the serial communication link between the PC and the Key Reader. 
  
Click OK to save selection(s). 
Click Cancel to abort. 
 
 

TOOLS TAB 

 

Email address input 
The email address for sending the data. The email address should be entered before an automated email 
procedure is initiated. 

Format Key Button 
The Format Key button is primarily for the large Flash Data key (No longer used). The normal ETM 32k 
Data key should not use this feature. 
  
  

OK, APPLY, CANCEL, HELP BUTTONS 
The command you pick in this field depends on what you intend to do with the changes you have made on 
a given screen. 

Rejecting Changes: Cancel 
If you do NOT want to keep the changes you have made, click the Cancel button.  This will return you to 
the main menu and negate any selections you made in the setup menu. 



Accepting Changes: Apply & OK 
If you want to keep the changes made, click Apply and then the OK button, if applicable.  This will store 
the setup configuration you entered as the default.  From that point on, every time you run FleetView, the 
setup you saved will be automatically loaded. 

 
 

HELP INFORMATION 
Help Information, also called the online manual, may be accessed several ways.  To access Help 
Information, follow one of the procedures below and this dialog box will be displayed. 
 

 
 
•        Press the F1 key on your keyboard, and follow the instructions. 

Or, 
•        With your pointing device (i.e. the mouse), click on Help and then ‘FleetView Help’.  Follow the 

instructions. 
Or, 

•        Click on the arrow/question mark icon (shown below) in the upper left-hand corner of the main 
menu. Follow the on-screen instructions to access the online manual to solve any problems 
associated with the program or a specific application. 

 

 
 



Clicking on the ‘Fleetview for Fixed Wing Manual’ radio button will bring up this Fleetview for Fixed 
Wing Program Operator’s Manual. 

 
 
Clicking on the ‘Shadin Technical Support Information’ radio button will bring up the following page: 
 

 
 
  



USING FLEETVIEW 7.30 
Once you have FleetView configured the way you want it, you can begin downloading information from 
DataKeys or manipulating data files. To run FleetView 7.30 for Fixed Wing, click START, slide to 
Programs, FleetView, and click on FleetView.  Or click on the FleetView icon on your desktop that was 
created by the installation program. These actions will start up the Fleetview Application Main page (as 
described earlier).  Once you are in the main program, there are two ways to navigate through the 
FleetView menus.  You can use the arrow keys to scroll along the row of available menu items.  To open a 
highlighted menu item, press the ENTER key. Finally, the pointing device (i.e. the mouse) can be used to 
select items from the menus.  Point to the item you want, and click the left mouse button.  The menu will 
automatically be opened. 
  

MENU BAR 
The Main Menus are where FleetView’s major functions can be accessed is Read, View, Print data from 
the Key, and perform key maintenance functions.  The following is a description of each menu item found 
in the main menus. 

WINDOW MENU 

The Window menu can be used to switch between the Database window (left side window), the Data Files 
window (upper right window), or the Report window (lower right window).  The mouse can also be used to 
select the active window and the item below. 

DATABASE WINDOW (LEFT SIDE OF MAIN PAGE) 

Base Folder 
FleetView’s organizational database structure is a three-tier design. (Base/Aircraft/Data File).  The user 
selects the base location, followed by the aircraft, and finally the particular data file s/he wants to view.  
This structure is particularly useful if the user is maintaining data for aircraft spread out over several 
locations. 
  
The Base Folder contains one or multiple aircraft folders. For example, if you are managing data files for 
ten aircraft spread over five different locations, this structure allows you to select the base you want to 
view. 

Aircraft Folder 
Opening an Aircraft Folder will expand and show the aircraft data files contained in the folder.  
Select/Click the aircraft data file you wish to view. 

Data File Selection 
Once an aircraft folder has been chosen, you can view any of its data files by clicking/selecting the Data 
File you wish to view. 

DATEFILE WINDOW 
When you click-on/select a Datafile in the Database window, all of the event reports in that file are 
displayed in the Datafile Window.   

REPORT WINDOW 
When you click-on/select a Record in the Datafile Window, all of the detail fields that are part of that event 
report are displayed in the Report Window. 



VIEW MENU 
To look at reports in an individual data file, select the data file.  To view a particular report, click on the 
report.  The contents of the report will be displayed in the report window.  From here you have several 
options as to what file format you want to view the data in.  Under the view menu, you will be given the 
following choices: 
  

MENU 
SELECTION 

DATA 
DISPLAYED 

Activity Shows all reports in the file 
Exceedances Shows only the exceedance reports 
Power Checks Lets user view power check reports 
Custom Lets the user define which reports will be 

shown 
Graph Provides a printable graph of the selected 

information. 
Refresh Resets all available data 
Options Provides access to the Properties window 
  
A description of each menu option is given below. 

ACTIVITY 
If you select Activity from the View menu, you will immediately see all reports for the currently selected 
data file. The data files window contains the data that is specific to the aircraft.  This data does not change 
unless someone alters the information contained in the Data Entry Mode of the ETM (This usually does not 
occur unless major work has been performed on the aircraft or the ETM system (i.e. engine replacement, 
modification to the ETM hardware or software, etc.). 
  
The Report window is the event summary.  This is a list of all the events the ETM recorded on the DataKey 
since it was last placed in the aircraft.  To the left of the event title is the event number.  This number 
indicates the sequence in which the event took place.  For example, on the previous page, the selected event 
number 045 indicates that it is the 45th event to occur since the key was placed in the aircraft.  To the right 
of the Event Description is the Time Stamp, the date and time of the Event. 
  
To scroll through events one at a time, use the up/down arrow keys.  To move quickly through the list use 
the PAGE UP/PAGE DOWN keys.  If you are using a mouse, left click on the scroll bar to page up and 
down through the list.  Once the desired report title is highlighted, pressing the ENTER key, or left clicking 
with the mouse will open a window containing the data in the selected report.  To return to the event list, 
press the TAB key twice, or click on the mouse in the event report window. 
  

EXCEEDANCE 
The ETM has specific manufacturer’s data on the aircraft it is installed in.  This body of data provides the 
ETM with the aircraft’s performance parameters.  If the aircraft exceeds or violates those parameters, the 
ETM will automatically record the exceedance on the DataKey as an exceedance report. 
  
The Exceedance menu is intended to allow the user to see, at a glance, how many times the aircraft 
exceeded its established operating limits.  Selecting the Exceedance menu will bring up a screen that is 
identical to the Activity menu described above.  The difference is that rather than listing all of the reports in 
the file, the exceedance selection lists only the exceedance reports. 
  
Note: There will be gaps in the numbers in this window.  When the Exceedance menu is selected, the 
program only displays the exceedances reports in the file.  There is no renumbering of events.  Therefore, 
event 12 in the Activity window will still be event 12 in the Exceedance window. 
  



Note: If you select the Exceedance listing and there are no exceedance reports in the file you are trying to 
view, the event report window will be blank. 

POWER CHECKS 
Selecting Power Checks from the View menu allows you to see all the recorded Power Checks in a file.  
Similar to the Exceedance selection, the window will have gaps in the numbers and there will be no 
renumbering of events.  Also, if viewing Power Checks is selected and there are no reports present, the 
window will be blank. 

CUSTOM REPORTS 
There are times when someone wants to look at a specific type of event that took place on the aircraft.  For 
example, if there is a suspected problem with the left engine, maintenance personnel might want to look at 
all of the data for the left engine.  To do this, they would need to look at starts, shutdowns, exceedances, 
etc.  The Activity and Exceedance lists do not lend themselves well to this type of task.  Sifting through the 
Activity list would be very time consuming and the Exceedance list does not give enough information. 
  
To make this task feasible, Shadin Avionics has included a utility to custom design a list based on the needs 
of the specific situation.  Using this utility, the user defines a filter for the data s/he wants to view, and can 
then save this custom report for later use.  The user can create as many different custom reports as 
necessary. 
   

Custom Report Window 

 

Retrieving a custom report 
Loading a custom report is only possible if there are previously created and saved custom reports.  (For 
instructions on how to create and save custom reports, see the following sections of this manual.)  From the 
menu bar, click on View and then slide to Custom and click.  The upper left window will provide you with 
a list of saved reports. 

 
Pull down the menu bar to view the reports.  Click on the specific report to select it.  If there is no report 
format loaded, FleetView will automatically create a blank one.  To load the selected report, click OK and 
you will be returned to the main menu with the report loaded. 

Creating a Custom Report 
To create a custom report, access the Custom Reports window.  Make sure no report is loaded in the Saved 
Reports window.  The window on the right, labeled All Report Types contains the specific type of reports 
you may include in your custom report.  To include any report type, highlight the report type by clicking on 
it with your mouse.  You may click as many report types, as you want at one time.  To deselect a specific 
report type, click on the highlighted report type again, or click refresh to clear your selections. 



 
The selections can then be added to your Custom Report by clicking the arrow pointing to the box labeled 
Selected Report Types. 
  
  

 
Your selected information will then appear in the Selected Report Types box. 
  

 
When you are satisfied with the Custom Report you have built, click Save As and assign the report a file 
name, then click OK.  At any time that you wish to deselect a particular item, click on the report type and 
click the arrow pointing to the All Report Types box.  To deselect the entire Custom Report, click Reset. 
  
  
Note: You may create a Custom Report to view specific report types by clicking OK.  Selected Data files 
will display information according to your Custom Report.  However, once you exit FleetView, the Custom 
Report will not appear again unless you assign the Custom Report a file name. 

Save As button 
This Save As command is used in saving custom reports that you wish to use again.  When you have 
created your report, click the Save As button and assign the report a file name, then click Save or Cancel to 
abort. 

OK button 
This selection activates the custom report format that you just loaded or created and saved.  When you use 
this command you will get a report summary that contains any and all reports that you defined in your 
custom report format.  The report summary is identical in function to the Activity and Exceedance reports 
summary. 
  
Reminder: In order to use a custom report again, it must be Saved.  Clicking OK only uses the custom 
report for that time you are running FleetView or until you change report types. 
  
Note: If the selected data file does not contain any reports of the type you have specified, FleetView will 
display a blank report event window. 



Cancel button 
Clicking Cancel, at any time, will exit the custom report window and return you to FleetView’s main menu. 

Reset button 
Clicking Reset clears all selections made.  Also, clicking the Reset button will clear any loaded report.  
However, changes will not automatically be saved unless the Save As procedure is followed. 
 
 

FILE MENU 
Located under the File menu is a list of functions for Key Operations that are applicable to downloading 
information from the DataKey and making administrative changes to the Key.  The key is sent to you 
already initialized and containing no data. 
  
To set up the Key Reader, please refer to the section titled Setting up Key Reader. 

KEY STATUS 
Every DataKey has a status.  A key’s status is basically its current condition, which could be one of several 
different descriptions.  A key could be initialized, normal, wrapped, or bad.  The Read Status command 
provides not only the key’s current condition, but several other pieces of information as well. 
  
To access the Data Key Status, first confirm that the Key Reader is properly configured and then insert the 
Key, click on File, and finally click on Read Status. 
  
The key’s status is displayed in a window called Key Header.  The Key Header window consists of two 
tabs labeled System Block and User Block. The data in the first tab comes from the system block of the key 
header, as well as various administrative data items.  The System Block contains: 
  

     Initialized: Date and time that the key was initialized 
     Records: Number of records written to the key 
     Key percent full to tenths of a percent 
     Size of the key 
     Key Write Failures: Number of write failures which have been recorded on the key 
     Format: Format revision level of the key header 
     Reader Version: Last two digits of software version number of the Key Reader 
     Last two digits of software version number of the Key Recorder that last wrote to the key 
     Operational Status: (Initialized, Normal, or Wrapped) 

  
Most users will generally be interested in only a few of the data fields listed above.  However, if something 
goes wrong with a key, the information presented in this window is important to Shadin Avionic’s 
Technical Support staff.  If you need help,  call our Technical Support Department. 
 
 
  



Key Header Display, System Block Tab 

 
The second tab in the Key Header window is the User Block.  The Key Administrative Entry controls this 
information.  The User Block contains information that may be entered or manipulated by accessing Key 
Admin under the File menu.  You may enter the Key ID or Filename, the Pilot, Dispatch, Flight, Fleet, and 
Remarks.  The KeyReader automatically reads data including the Model #, Revision, Registration, Serial #, 
and the ETM Version. 
  

Key Header Display, User Block Tab 

 
Click OK 

  
Note: If the message “Cannot set key reader baud rate” is displayed, follow this procedure to resolve the 
problem.  Click on View, slide to Options and click on the Key Reader Tab.  Confirm that the correct Key 
Port is selected.  Run Test to verify the settings. 



KEY READ 
The Read command initiates the downloading of data from the key.  When you read a key, the program 
asks you for several pieces of information so that it knows where to put the file it is downloading.  It asks 
for the base name, the aircraft name, and a name for the data file. 
  

 
Click OK 

  
FleetView uses the “Bed Down Base” name shown on the ADMIN screen as the default value for the base 
name field.  The user may enter a new name in this field or pull down the Base menu and click on an 
available Base name. 
  
The aircraft name, by default, will be the A/F serial number stored on the DataKey.  FleetView will 
automatically create an aircraft directory using this A/F serial number.  If you want to add the data file to an 
aircraft currently on the system, select the name by pulling down the Aircraft menu and clicking on an 
available aircraft name.  Also, note that FleetView will not allow the user to create a new aircraft name that 
doesn’t correspond to the A/F serial number stored on the DataKey. 
  
By default, the data file name corresponds to the Key Id Code.  The user may modify the file name as 
desired.  The only limitation on file names occurs when the file name already exists or there is an illegal 
character, as defined by the operating system, in the name.  If you enter the name of a file that already 
exists, the data that you are currently reading into the system will be added to the data that is already in the 
file.  The visible effect of this can be seen when you view the data file.  There will now be a larger number 
of events. Note: If you want to delete a directory or file you must use the Microsoft Windows Explorer to 
do this procedure. 
  
After the key has been read, it is automatically initialized and ready for recording new data. 

A Warning About Changes To Your Aircraft 
Aircraft are constantly being altered.  This includes repairs, modifications, updates, replacements, etc.  As a 
result, the information about the aircraft is constantly being altered as well.  The ETM installed in the 
aircraft is programmed with much of this information and writes portions of it to the key.  The data 
includes the following: 
  

     Aircraft model 
     Aircraft registration number 
     Airframe serial number 
     Engine serial number(s) 
     ETM software version 

  
Although the aircraft's model, registration, and serial number will probably never change, the engine serial 
number(s) will change if an engine must be replaced.  Also, the ETM software version number will change 
if you receive a software update. 
  
If anything happens to cause a change in your constant data, you must take precautions to protect the 
integrity of the data you have collected.  First, remove the key from the aircraft before the change is made, 
and read the key.  Then, immediately after the change, place a freshly initialized key into the aircraft and 



proceed with normal operations.  When it is time to read the key start a new data file.  DO NOT ADD 
THIS DATA TO AN EXISTING DATA FILE.  If there is a change in the constant data in the middle of 
the file it will appear as though the entire file was collected under the constant conditions that existed at the 
start of the file.  You may end up with major errors in your data.  For example, you might attribute power 
check reports and exceedances to the wrong engine. 

Data File Partitioning 
If you decide to add key data to an existing file, you should keep in mind that you cannot keep adding to 
the same file indefinitely.  Every time data is added to a file, the file grows larger.  Eventually, it will reach 
a size that it is impossible for FleetView to handle.  It is a good idea to add data to a file for a month at 
most, or after about 15 or 20 reads of the DataKey. 

 
In the event that a file does get too large for FleetView, please contact Shadin Technical Support 
department. 
  

KEY INITIALIZATION 
The initialization of the DataKey is a function that can be invoked directly by selecting Initialize from the 
Key Menu.  When the key is initialized, the status changes from normal or wrapped to initialized.  To 
initialize a key, follow the procedure below. 
  
1.      Click on File, slide to Initialize Key, and click. 
  
2.      The Key Reader Baud Rate will be set and FleetView will ask you if you want to initialize the key. 

 
Click Yes 

  
3.      Clicking Yes begins the key initialization.  When complete, the Key Header window will appear at the 

System Block tab.  This tab contains the current data on the key after initialization. 
  

Key Header Window, System Block Tab 



 
Click OK 

  
  
  
The number of records is set to 0 and the percentage full will become 0%.  The date and time (from the 
PC's clock) at which the initialization was performed will also be written to the key.  The previous 
initialization date and time, number of records, and percent used will be still be retained in the key, so that a 
recovery may be performed. 
  
Additionally, the initialize function is automatically invoked immediately following the read of a key.  The 
automatic initialization of the key prevents the pilot from reading a key, forgetting to initialize it, and then 
placing a nearly full key into the aircraft and expecting it to be empty.  This could result in wrapping of the 
key and loss of data. 

KEY RECOVERY 
Key Recovery is the opposite of an initialization.  A recovery may be performed any time a key has been 
initialized, with one restriction: the key must NOT have been written to since it was initialized.  If the key 
was placed in an aircraft and written to by an ETM, it cannot be recovered. 
  
When a recovery command is given, the previous initialization date, number of records, and percent used 
will become active and the data on the key will be available for reading again. 

KEY ADMINISTRATIVE ENTRY 
The Administrative Entry function allows you to write to the key header the following administrative data 
fields: 

     Key ID code (filename) 
     Bed Down Base 
     Pilot's name 
     Fleet Number 
     Flight Number 
     Remarks 

  
The Key ID code (filename) is used as the suggested file name when you read data from the Key.  Bed 
Down Base is used as the suggested BASE directory when data is read from a DataKey.  The rest of the 
administrative entries can be used in any way you like, as they are strictly for your information.  The data 
will show up in the key header report, which the first report is written to the data file when the key is read. 
  
Assume, as an example, which you only want to change the Key ID code field, and leave all of the other 
fields as they are.  You will want to first select the File Menu and then Status Read to get the current 
contents of all the fields.  Then select Key Admin under the File Menu to show all of the fields on a screen 
that you may edit.  Edit the Key ID code and press Enter or click on OK. 



  
DataKey™ Administrative Display 

 
  

PRINT 
To create a printed copy of the reports, click File, then Print. 
  
FleetView 7.30 for Fixed Wing provides the option of printing the Report Summary or the Full Reports.  
Within these two choices, FleetView allows you to print: 
•        All Reports 
•        Current Custom View 
•        Range of Reports 
  
When a selection has been made, click OK to begin printing. 

 

Print Summaries: All Reports 
Selecting the Print Report Summaries All Reports option will print an event list that will look identical to 
the event list window that appears on your screen when you select the view command. 

Print Summaries: Current Custom View 
Selecting the Print Report Summaries Current Custom View will print the information in the Data Files 
window according to the folder that you have selected.  

Print Summaries: Range of Reports 
This print option lets you select a range of reports to print.  For example, if you wanted to print the list of 
events that comprised an entire flight you might want to only print events 12 through 23.  When you select 



this option, the From and To boxes below the Range of Reports will become accessible.  Enter the report 
number you are printing from and to.  Click OK to begin printing. 

Print Full Report: All Reports 
If you select the Print Full Report All Reports option, FleetView will print every event in the data file in the 
complete and detailed report format.  This format is comparable to the detailed report you get when you 
select an individual event in the viewing window. 

Print Full Report: Current Custom View 
This option allows you to print the complete report of the Current Custom View selected, including 
information from the Data Files window and the Report Window. 

Print Full Reports: Range of Reports 
This print option allows you to select a range of reports and print the full report.  For example, if you 
wanted to print the list of events that comprised an entire flight you might want to only print events 12 
through 23.  When you select this option, the From and To boxes below the Range of Reports will become 
accessible.  Enter the report number you are printing from and to.  Click OK to begin printing. 

PRINT PREVIEW 
Selecting this option allows you to view the report you are printing on your computer.  To use print 
preview, first select the file or folder you wish to view and then click on File and slide to Print Preview 
and click.  Then, FleetView will provide you with options to view the print preview.  This is the same 
window as the Print Report Selection.  Make your selection and click OK.   FleetView will then provide a 
print preview according to the selections you have made. 
  

Print Preview Screen 

 
At the Print Preview screen, there are various options available to you through the control buttons along the 
top of the screen. 
  
Print: This button allows you to print the document you are previewing. 
  
Next Page: Takes you to the next page of the document in print preview. 
  
Previous Page: Returns you to the page preceding the page you are viewing. 
  
Two Pages: Allows FleetView to display two pages in the print preview screen. 
  
Zoom In: Enlarges the display of the document. 
  
Zoom Out: Decreases the display size of the document. 



  
Close: Returns you to the FleetView main menu. 
 
PRINT SETUP  
Used to change printer, paper, and orientation.  

 

 

EXPORT TO EXCEL FILE FORMAT 
However, to convert a file to the Microsoft Excel file format, the specific file should be highlighted and 
loaded by a double click on the selected file. Wait for the file to be loaded. Open the File menu and click on 
‘Export to Excel file format’.  A progress dialog will pop up with the option of cancel the operation. Note: 
THE MICROSOFT EXCEL SOFTWARE SHOULD BE INSTALLED, IF YOU ARE GOING TO 
USE THE EXCEL FILE EXPORT FUNCTION. 

 
When this Excel Export Function is completed, a Window will appear indicating the filename and the 
successful conversion. By clicking on the OK button the Excel software open automatically and load the 
converted file. However, when the Cancel button is pressed, the converted file could be opened later with 
the Excel software or other compatible software that could read Excel file formats. (Relevant exceedances 
values are displayed in red). 

 
  



  
An example of the Excel file format is: 

 

 

EXPORT TO *.DAT FILE 
  
The FleetView for DOS format is only a debugging tool for the Shadin Technical Support. Normally this 
feature is disabled but you could use a certain key sequence to activate it temporary. 
 
To convert a specific file to FleetView for DOS format, press the ‘Ctrl” and ‘Shift’ keys simultaneous and 
keep pressing these keys. Highlight the file by clicking on it once, then open the File menu and click on 
‘Export to *.dat file’. When this Export Function is completed, a Window will appear indicating the 
filename and the successful conversion. 
  

 
Click OK 

  

 

TOOLS MENU 
The Tools Menu serves two main functions.  It is used for the translation of FleetView data into ECTM 
data, and to convert data from the old DOS data file format to the new Windows data file format. (This 
DOS data convert feature is for backward compatibility only. In normal operation it is not used.) 
  
If you own a copy of the Pratt & Whitney ECTM IV program, you can use FleetView to translate power 
check data from your data files into the ECTM program’s database.  If you wish to send data files to a 
remote site, it is recommended that you use a commercially available email or ftp program. Note: You 
could also use the automated email feature in FleetView, if the Microsoft Outlook is configured. (Please 
read the appropriate subject sections in this manual). 



Translate 
This section only applies to those users who have purchased and installed the Pratt & Whitney ECTM IV 
software and want to automatically enter the power check data samples taken by your ETM into your 
ECTM database. 
  
Warning:  All attempts to perform a Trend analysis on the data read by this 
program must be done only by fully qualified personnel as defines by Pratt & 
Whitney Canada Requirements. 
 
 Warning: The Pratt & Whitney software has a restriction on the filename and pathname. It could not 
handle long filenames. The filename should be in an 8.3(DOS) format if you are going to use the Pratt 
& Whitney software. Also, the pathname and the filename should not exceed thirty five (35) characters.  
If for some reason you do not adhere to these restrictions, the translated data will not be loaded into the 
Pratt & Whitney ECTM database. 
  
First, make sure your Pratt & Whitney ECTM IV path is correctly entered and saved in the Directory Tab.  
To set the path, click on View, then Options, and finally the Directory Tab.  Once the path is set correctly, 
click Apply and then OK.  Next, select Translate from the Tools Menu.  This will give you a menu of all of 
the data files for the currently selected aircraft.  
 

 
  
Mark the files you would like to translate by opening a folder and clicking on or pressing ENTER on each 
file you want marked, or click on them with the mouse.  When you mark a file, a small check will appear 
next to it.  If you mark a file and then decide you do not want it translated, click on it again and it will be 
unmarked.  When you have chosen the data files you would like translated into the ECTM file format, click 
Translate (or press Alt + T). 
 

 
Make Selections, Click Translate 

  



You will now be asked how many of the power checks in the file you would like to include in the 
translation.  Your choices are All, One per flight, and One per day.  Once you make your selection, the 
translations will begin.  (Remember that the Minimum and Maximum powercheck altitudes that you 
entered in the Setup screen will be used in determining which power checks are translated.)  
 

 
  
If you selected All powerchecks, each power checks report (with an altitude that is within the selected 
range) in the data file will be included in the translation.  If you selected One per flight, FleetView will 
allow only one power check report per engine for each takeoff report that is found in the file.  If you 
selected One per day, FleetView will allow the first valid power check for each engine that has a different 
date than the last power check. 
  
  
  
As each file is being translated, a message ("Processing ‘FILENAME’ ") will appear in a window in the 
center of the display. 
  
In the event that there are no power check reports in the file (or none that meet the criteria to be converted), 
you will see an error message explaining this. 
  

 
FleetView will provide a window with a translation summary of the file(s) translated. 

  
  
Once the files have been translated, you will be asked whether you would like to load the data into the 
ECTM database. Make your selection with the arrow keys and press CTRL and ENTER simultaneously to 
continue.  If you selected to load the data into the ECTM database, the FleetView program will load the 
power checks into the ECTM database. 



 
 
FleetView will then indicate the load is finished and ask you to confirm that the load succeeded. 
 

 
  
  
  

Convert 
This function performs the conversion of old data files in the FleetView DOS format into the FleetView 
Windows data file format.  If during the conversion a corrupt data item is encountered, the conversion 
routine will display a message.  The user may then select to either quit the conversion or continue.  If 
continue is selected, the conversion routine will proceed with the conversion. 
  
To access the convert function, click on Tools, and then Convert.  FleetView will provide the window 
containing old data files.  Double click on a folder to access the files, which will appear in the box next to 
the folders.  To select a file for conversion, click the box next to the file name so a check mark appears.  To 
select all the files, click Select All.  To deselect the file, click the box again and the check mark will 
disappear.  When you are finished selecting the files to be converted, click Convert.  When conversion is 
completed, click done.  If you wish to abort the conversion routine, click Cancel. 
  
Note: This procedure is also performed in Initial Setup, steps 8-11.  If you converted all data files at that 
time, there will be no old data files to convert. 
  
  

E-MAIL FUNCTION 
The E-Mail Function will only work if the Microsoft Outlook® is loaded on your PC. Note: Outlook 
Express is not the full version of the MS Outlook; consequently this feature will not work if only  
Outlook Express is installed!   
 
Note: For the email function to work properly, you must be connected and have Fleetview configured 
to send email. (Check with your system administrator.)  To configure Fleetview with an email address 
select View, then Options, then the Tools tab and enter the email address as shown below.  Click OK to 
save. 



 
 
 
To use this email function, highlight a data file and then right click on the pointing device (i.e. the mouse). 
This opens the popup menu and click on ‘Send To…’ The following ‘Send Data by Email’ screen will 
appear. 

 
CLICK OK 

  
Once you have clicked on OK, the procedure is complete. 
Wait until the next screen appears to validate the email process. 
 

 
  



GRAPHING CAPABILITIES 
FleetView for Fixed Wing is equipped with Graphing Capabilities that allow you to organize specific 
information in graph format with just a few clicks of the mouse.  First, you must make sure your PC is set 
to at least 800 by 600 resolutions.  If it is not, you will get a warning dialog box. 
  
Note: To set your resolution, you must access the Control Panel, click on Display, and finally the Settings 
Tab.  Here you will have the opportunity to change your resolution to at least 800 by 600 if you need to. 

Start Temp/Voltage, Ground Power Check Graphs 
To create a Start Temp/Voltage or Ground Power Check graph, open the data file to display reports in the 
Report Event Window.  Locate the report you intend to graph and follow the steps below. 
  
1.      Right Click on Report or highlight Report and click on View. 
  
2.      Slide to Graph. 

 
  
3.      Slide to Start Temp/Voltage or Ground Power Checks. 

 
  
4.      Slide to specific Engine and click. 

 
  
  
  
5.      FleetView for Fixed Wing will then provide the option of graphing all Reports or a Range of Reports.  

To select all, click the circle next to All.  To select the Range of Reports option, click the circle next to 
Range and enter the number you are printing from and the number you are printing to in the boxes 
below.  For example, if you wished to graph only starts 146-153 in a specific file, you would enter 146 
after “From” and 153 after “To.” 

 
Make Selections, Click OK 

  
  
  



Example Start Temp/Voltage Graph 

 
  
  

Example Ground Power Check Graph 

 
  

Reading the Graph 
Use the corresponding symbols to interpret information in the graph.  A box containing the symbols is 
located beneath the graph along with information pertaining to the aircraft and file. 
  

Graph Key and Aircraft/File Information 

 

Printing and Closing a Graph 
To print the graph, click Print in the upper right hand corner of the screen.  To return to the main menu, 
click OK or close the screen by clicking r in the upper right hand corner. 



Snapshot Graph 

 
FleetView for Fixed Wing allows you to Chart Snapshot files.  To graph a Snapshot file, access the Chart 
by highlighting the file, right clicking with your mouse or clicking on View, and sliding to Graph.  From 
there you will have the option of selecting Left Engine, Right Engine, or Airframe. 

  
  

When you have made your selection, the graph will appear.  
  

Example Airframe Snapshot, Chart Tab 

 
  
Note that the screen provides two tabs, one for the Chart and another for the Table. 

Chart Tab 
The Chart displays various characteristics concerning the file depending on your selection of Left Engine, 
Right Engine, or Airframe.  Regardless, the graph displays the data in increments of 20 seconds (the 
smaller vertical line between numbers indicates the 10-second increment).   
  
To scroll through the Chart, click Play, and data will move from right to left across your screen.  You may 
select the speed of the scrolling by adjusting the last sliding button, which provides the option of scrolling 
at various speeds from slow to fast.  To pause or resume scrolling, click on the Play/Pause button.  To 
return to the beginning of the data, click on Rewind. 

Chart Controls 

 
 
OK - Exits Chart 
Print - Prints Current Chart 
Pause - Begins or Pauses Scrolling 
Rewind - Returns to Beginning of Chart 
Speed Control slide bar – Sets the Speed Rate 



Table Tab 
The second available screen in a Snapshot graph is the Table Tab.  To access this screen, click on the tab 
marked Table.  The table contains all the readings found in the Chart and the available control options 
function the same. 
  

Example Airframe Snapshot Graph, Table Tab 

 
You may access specific points on the Chart by using the Table as your guide.  Likewise, you are able to 
access specific information in the Table by using the Chart as your guide. 
  
To view specific information in the Chart, first access the Table screen.  The column labeled “Time Stamp” 
contains dates and times corresponding to positions in the Chart.  Next, highlight the date and time you 
intend to view by clicking on it with your mouse.  Finally, access the Chart Tab and the Chart will show, 
depending on the initial graph selection, a series of black dots indicating the selected position on the Chart.  
  
For example, let’s say from the previous example screen you wanted to see the position of October 31, 
1997 at around 10:40.  You scroll through the Table and make your selection: 31 OCT 97 10:42:20. 

 
Finally, you click on the Chart Tab to display the position of OCT 31 97 10:42:20. 
  



 
  
Reminder: The black dots in the Chart indicate the exact position of your selected date and time in the 
Graph. 
  
Using the Graph may also use this procedure to discover specific information in the Table.  To do so, select 
a specific point in the Chart and click on it.  Remember that the Chart is divided in 20-second increments 
(the smaller vertical line between numbers indicates the 10-second increment), but individual seconds may 
be selected.  When you have selected a point, click the Table Tab.  The Table will display your selected 
date and time in highlighted format, along with the corresponding information. 
  
 

CONTACTING SHADIN 

TECHNICAL SUPPORT 
This Operations Manual and FleetView’s Help Files are provided to assist you in using FleetView 7.30 for 
Fixed Wing.  If you encounter any problems while using FleetView, please refer to these tools.  However, 
if you experience a problem the Operations Manual or the Help Files cannot solve, please contact Technical 
Support by: 
  
Phone: 1-800-388-2849 or (952) 924-1123 
E-mail: repair@shadin.com 
Fax: (952) 924-1122 
  
If contacting by phone, please be at your computer and prepared to explain the problem in detail to the 
technical support staff. 
  
If contacting by fax or e-mail, please include all information associated with the problem, including any 
error messages and information about your ETM.  Also, please include your name, phone number, and 
mailing address. 

SALES 
Shadin’s knowledgeable Sales Team is ready to assist you with any questions you may have regarding your 
next purchase.  Please contact the Sales department at: 
  
U.S.: 1-800-328-0584 
International: (952) 927-6500 
Fax: (952) 924-1111 
E-mail: sales@shadin.com 
For more information, visit Shadin on the web at: WWW.SHADIN.COM 


